
Guía del Usuario de Vensim    http://atc-innova.com  1 

Recursos de Vensim en español 
 

 
 

 
 
 
 
 
 
 
 
  

Información 
 

http://atc-innova.com 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://atc-innova.com/


Guía del Usuario de Vensim    http://atc-innova.com  2 

6   Construcción de un modelo de simulación 
 
 
Un modelo de la población 
 

 

Este capítulo muestra la construcción de un modelo de simulación de la población de 

conejos. El proceso de creación de un modelo empieza con trazar el diagrama de un modelo, 

después se escriben las ecuaciones y especifican las cantidades numéricas. Después se 

simula el modelo obteniéndose unos resultados que se como un dataset (resultados). Por 

último los resultados de la simulación pueden ser examinados con instrumentos de análisis 

para descubrir la conducta dinámica de las variables del modelo. La construcción de un 

modelo sigue unas pautas de crear, probar, y volver a crear, iterando hasta que el modelo 

cumple los requisitos. La depuración (hasta lograr que un modelo se comporte como 

deseamos) y el análisis del modelo (investigando su comportamiento) son de utilidad en el 

proceso de refinar el modelo. Reality Check o la comprobación con la realidad es una 

herramienta para ayudar en la construcción y el refinamiento de los modelos que describe en 

el Capítulo 14.  

 

El comportamiento de un modelo de simulación en Vensim viene determinado únicamente 

por las ecuaciones que recogen las relaciones entre las variables. Podemos consultar el 

listado con todas esas ecuaciones en los modelos de simulación incluidos en esta Guía. El 

esquema de un modelo (sea el diagrama causal o el diagrama de flujos) es una forma de 

mostrar las relaciones entre variables. Vensim comprueba la coherencia entre el esquema y 

las ecuaciones modelo, pero esta información puede ser omitida o puede hallarse oculta en 

los esquemas. Cuándo construya un modelo de simulación compruebe que las ecuaciones de 

su modelo coinciden con las del manual. Si hay una discrepancia en la apariencia de los 

esquemas puede ser porque usted ha omitido por descuidado algo o ha puesto una opción 

que influye en el aspecto del esquema.  
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Normas de Vensim 
 

Nombres 
 

Los esquemas que representan el modelo deben ser mostrados con claridad para facilitar la 

construcción, el análisis, y la presentación. La mayor parte de los modelos de este manual 

siguen las normas que recomendamos, aunque puede emplear otra forma si lo desea.  

 

Los niveles se escriben con mayúscula, por ejemplo: Población 

 

Los flujos, las variables auxiliares, las constantes, las tablas de datos, y otros tipos de 

variables se escriben en minúsculas; por ejemplo: vida media 

 

Dibujo 
 

Los niveles o acumulaciones se escriben usando el icono Box Variable (Caja). Cuando se 

usa la Caja, la variable es definida un nivel. Cuándo abre el editor de la ecuación verá que 

las variables dibujadas con el icono de la Caja instrumento se hallan definidas como niveles 

(Type: Level). Puede cambiar el tipo en el editor de la Ecuación, o escribir variables sin la 

caja que sean niveles pero esto puede causar la confusión y no es recomendable excepto si 

existen especiales propósitos.  

 

Los flujos se dibujan generalmente con el icono de Rate (Flujo). Por omisión los flujos son 

añadidos con un nombre y una flecha para indicar un flujo en una determinada dirección. 

Puede dejar un flujo sin nombre pulsando la tecla Esc cuando el aparace la caja del editor 

del flujo. Puede agregar una flecha al otro extremo del flujo pulsando con el botón derecho 

del ratón en el pequeño circulo de la tubería del flujo (con el instrumento del Move/Size 

(Mueve/Tamaño) activado) y marcar en el menú la opción Arrowhead (flecha con cabeza) 

para indicar un flujo de dos direcciones. Excepto en PLE y PLE Plus puede cambiar también 

la conducta predefinida con el botón derecho del ratón sobre el flujo para mostrar las 

opciones y desactivando Query Valve Name o One Way Flow  (Flujo de una dirección).  

 

NOTA IMPORTANTE La presencia o la ausencia de una flecha en un flujo no tiene efecto 

en la ecuación de ese flujo en un modelo de simulación. La ecuación de un flujo puede 

permitir disminuir un nivel, aunque una sola flecha indica en el dibujo que el flujo hace 

aumenta el nivel. Es la ecuación la que determina como se comporta el flujo.  

 

Las Constantes, Auxiliares (tablas, y otras variables) se añaden generalmente con el icono 

Variable como palabras en una caja transparente o con la forma Ninguno. Algunas normas 

para el dibujo de las Variables Auxiliares y las Constantes les dan una forma del Círculo 

(generalmente con el nombre debajo), pero esto complica el esquema sin aumentar la 

información transmitida. Asignar formas diferentes para cada tipo variable aumenta la 

información transmitida, pero no existe ninguna norma universal para ello y es conveniente 

evitar que el aspecto visual sea complejo. Para construir un modelo de simulación 

recomendamos y utilizaremos en esta documentación los esquemas que contienen los 

niveles en cajas, los flujos con válvulas  y todas las otras variables sin ningún símbolo.  

 

Esto es válido excepto para PLE y PLE Plus donde se puede agregar más opciones al menú 

del Dibujo y cambiar la conducta de los iconos en el menú de las Variables del Dibujo y se 

generarán formas como Círculos o Diamantes.  
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Dibujar el modelo Conejos 
 

 

- Ponga en marcha el Vensim      

 

- Pulse en la opción New Model (Nuevo Modelo) o escoja la opción File>New Model ... el 

Archivo > Nuevo Modelo… 

 

- En los menús de Model Settings (zona de límites de tiempo) escriba 30 para el FINAL 

TIME (PERIODO FINAL), escriba (o escoja de las opciones que se desplegan) 0,125 para 

el TIME STEP (PASO de TIEMPO). Pulse en las opciones que se desplegan pra Units for 

Time (Unidades de Tiempo), y escriba Año (en español). Pulse en OK (o Intro).  

 

- Seleccione el icono Box Variable (Caja) y pulse en algún lugar en medio de la pantalla. 

Escriba el nombre de Población de conejos, y pulse Intro.  

 

- Seleccione el icono de Rate (Flujo). Pulse una vez (solo pulsar y liberar el botón de ratón) 

unos 5 cm. a la izquierda del nivel Población de conejos, después mueva el cursor 

sobre Población y pulse una vez más. Escriba el nombre nacimientos y pulse Intro.  

 

- Pulse una vez en el nivel Población de conejos y mueva el cursor unos 5 cm. hacia 

la derecha y pulse otra vez. Escriba el nombre muertes y pulse Intro.  

 

- Seleccione el icono Variable. Pulse en el dibujo debajo de nacimientos, escriba tasa 

de natalidad y pulse Intro. Pulse en el dibujo debajo de muertes, escriba 

esperanza de vida y pulse Intro.  

 

- Seleccione el icono Flecha, pulse una vez sobre tasa de natalidad y otra vez sobre 

nacimientos. Pulse una vez sobre esperanza de vida y otra vez sobre muertes.  

 

- Pulse una vez Población de conejos, después debajo y a la izquierda de 

Población de conejos, después una vez en nacimientos.  

 

- Pulse en Población de conejos, después debajo y a la derecha de Población 

de conejos, después una vez en muertes.  

 

- Pulse en Save (Guardar) y guarde su modelo en el directorio guide\chap06. Asigne un 

nombre a su modelo (nosotros le llamamos pop_guia.mdl).  

 

La estructura del modelo de Población ya está completa y es como se muestra en la figura 

siguiente. Existe un ciclo positivo de Población de conejos  a nacimientos que 

aumenta la Población de conejos, y un ciclo negativo en muertes que disminuye 

la Población de conejos.  
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Escribir las ecuaciones 
 

 

La estructura del modelo está completa. Sin embargo, si trata de simularlo recibirá un aviso 

que le indica que el modelo tiene errores y no puede ser simulado. Para simularlo, necesita 

definir un conjunto de ecuaciones que describan cada relación. Estas ecuaciones son 

expresiones algebraicas sencillas que definen una variable en función de las otras con las 

que se halla conectados por relaciones causales. Por ejemplo:  

 
nacimientos = Población de conejos * tasa de natalidad 

 

Observando el dibujo verá que la tasa de natalidad no tiene las causas; es una 

Constante en el modelo. Esta Constante tiene un valor numérico que definiremos más tarde. 

Escribiremos las unidades de la medida en cada ecuación que definamos. Las unidades nos 

permiten verificar la consistencia dimensional entre todas las ecuaciones. La consistencia 

dimensional es una revisión formal de que la estructura modelo es correcta. Utilizaremos la 

opción Model>Units Check (Modelo>Revisar unidades (Ctrl + U) para revisar el modelo 

completo después de que hayamos definido todas las ecuaciones.  

 

- Pulse en el icono de Ecuaciones.  

 

Todas las variables en el modelo se mostrarán en negro. Los elementos resaltados señalan 

que variables falta definir o cuales de ellas están incompletas. Cuando complete las 

ecuaciones para cada una de las variables los elementos resaltados desaparecerán. Pulse la 

opción Model>Check (Modelo>Revisar) (Ctrl + T) o el Check Model (Revisión del 

Modelo) en el Editor de ecuaciones para revisar y mostrar las que se hallan pendientes de 

definir. 

 

- Pulse en la variable nacimientos.  

 

Se abrirá el Editor de ecuaciones. La apariencia exacta del Editor de la ecuación dependerá 

de la configuración de Vensim que tenga definida. Vensim PLE y PLE Plus tienen a un 

Editor de ecuaciones simplificado, aunque los elementos principales son los mismos.  

 

Variables de tipo: Auxiliar 
 

En la parte superior del editor puede observar el nombre de la variable activa: nacimientos. 

La lista de opciones desplegable que se halla en la izquierda  indica el tipo de la variable: 

Auxiliary (Auxiliar). Vensim considera del tipo Auxiliar tanto los flujos como las variables 

auxiliares. Pulse  en la flecha hacia abajo para ver los otros tipos. Cerciórese que la opción 

Auxiliar se halla seleccionada todavía cuando cierre la lista. Ponga el cursor en la zona de 

edición de la ecuación (próxima al signo = ).  
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Complete la ecuación de nacimientos como se indica en la imagen anterior (en la zona de 

edición. 

 

Ya sea: 

 

- Escribiendo Población de conejos * tasa de natalidad 

 

o bien: 

 

- Pulsando en la variable Población de conejos en la lista de variables (en el centro 

del Editor de ecuaciones) después pulse el símbolo *  (o selecciónelo en el teclado del Editor 

de Ecuaciones) y luego pulse en tasa de natalidad de la lista de variables. 

 

Se pueden añadir espacios en blanco y separadores de línea para conseguir mayor claridad 

de la ecuación, pero no son imprescindibles. Para añadir una nueva línea pulse la tecla Ctrl y 

luego Intro. Observe que no puede añadir una línea en el nombre de una variable. 

 

Ahora agregaremos las unidades de nacimientos.  

 

Escriba las unidades  conejo/año en el menú de Unidades. Esto indica que medimos la tasa 

de natalidad en conejo por año. Pulse en OK o pulse Intro.  

 

Si la estructura y la ecuación modelo concuerdan y no hay los errores de la sintaxis de la 

ecuación, el cuadro de diálogo desaparecerá. Si hay problemas con la estructura o las 

ecuaciones, aparece un mensaje de error que indica donde está el problema.  

 



Guía del Usuario de Vensim    http://atc-innova.com  8 

Variables de tipo: Nivel 
 

- Pulse en Población de conejos.  

 

Se abre el Editor de la ecuación y ahora es ligeramente diferente de lo que vimos con la 

variable nacimientos.  

 

 

 
 

La lista desplegable muestra a la izquierda el tipo de la variable: Level (Nivel). La izquierda 

de la caja de edición indica la función de INTEG que define un Nivel (integrando la variable 

con el tiempo). La ecuación ya aparece escrita la caja de edicion de la ecuación porque en el 

dibujo conectamos los nombres de los flujos de nacimientos y muertes al Nivel, y 

por este motivo Vensim coloca automáticamente los flujos en la ecuación del nivel. Los 

flujos entrantes en el nivel son considerados positivo (entrada) y en cambio los flujos 

construidos como salidas del nivel son considerados negativos (vaciando los niveles). Si se 

dibujan los flujos en una dirección diferente que el signo, podemos cambiarlo en el Editor de 

la ecuación. La ecuación para este Nivel es correcta, los nacimientos añaden a Población, las 

muertes restan de la Población, así que no necesitamos hacer cambios.  

 

El Editor de la ecuación para un Nivel tiene una caja de edición adicional para poner el valor 

inicial; colocamos ahí el cursor.  

 

- En la caja de edición del Initial Value (Valor Inicial), escriba 1000.  

 

Este valor es el número inicial de conejos al comienzo de la simulación (tiempo cero).  

 

- Escriba conejo en la caja de las unidades. Pulse en OK o pulse Intro.  

 

- Pulse en la tasa de natalidad. Escriba el número 0.125 en la caja de edición.  
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- Escriba en las unidades fracción/año  (si prefiere, entre en su lugar 1/año), esto significa 

que la tasa natalidad se mide en la fracción (de conejos) por año. Otra manera de explicar 

esto es (conejos nacidos/población de conejos) /año   (conejo/conejo)/año = fracción/año  

(conejo y conejo se anula). Pulse OK o pulse Intro.  

 

- Complete las dos ecuaciones restantes como se indica a continuación.  

 

Todas las variables del modelo deben aparecer claras (no resaltadas en negro) en el dibujo 

ya que las hemos definido. Las unidades que han sido entradas inicialmente pueden ser 

modificadas pulsando en la flecha para desplegar las unidades y escogiendo la más 

apropiada. 

 

Ecuaciones del modelo pop_guia.mdl 
 
esperanza de vida = 8 

Units: año 

  

muertes = Población de conejos/esperanza de vida 

Units: conejo/año 

  

nacimientos = Población de conejos*tasa de natalidad 

Units: conejo/año 

  

Población de conejos = INTEG (+nacimientos-muertes, 

Inicial value: 1000) 

Units: conejo 

  

tasa de natalidad=0.125 

Units: 1/año 
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Revisión de la sintaxis del modelo y los errores en las unidades 
 

 

Antes de simular el modelo hemos de verificar que no existan errores en las ecuaciones y 

unidades.  

 

- Escoja  Model>Check Model (Modelo>Revisión del modelo) del menú (o pulse Ctrl + 

T); y debe recibir un mensaje quee dice “Model is OK”.  

 

Si el modelo tiene los errores el Editor de la Ecuación le mostrará la variable que contiene el 

error. Verifique que la ecuación utiliza todas las entradas y tiene el mismo aspecto que en el 

listado anterior. Verifique que la estructura de su modelo es igual que en el esquema 

anterior.  

 

- Selecciones Model>Units Check (Modelo> Revisión de las Unidades) (o pulse Ctrl + 

U); y debe recibir un mensaje que dice “Units are OK”.  

 

Si existe un error en las unidades, lea la ventana de salida para ver qué variables fallan la 

revisión. Abra el Editor de la ecuación en cada variable y verifique las unidades con el 

listado anterior. Las unidades que no coinciden a menudo se deben a una formulación pobre 

o inexacta de la ecuación.  

 

NOTA. La prestación Units Check puede ser activada también desde las herramientas de 

análisis menos en PLE y PLE. Ha de modificar el menú de herramientas de análisis (menú 

Tools>Analysis Toolset>Modify ... ) (Herramientas> Herramientas de análisis>Modificar...)  

y agregar la opción de Unidades, o bien abrir el menú de herramientas de análisis 

default2.vts que contiene la prestación Unidades.  
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Sinónimos 
 

Puede querer entrar las unidades en su forma en plural así como el singular. Por ejemplo, 

tanto conejos como conejo. Esto fallará una revisión de las unidades porque Vensim no ve la 

forma en plural y en singular como la misma palabra. La manera más fácil de evitar este 

error es indicar que las unidades conejo y conejos son equivalentes o sinónimos.  

 

- Escoja el menú Model>Settings.. (Modelo>Parámetros...)  y pulse en la opción de Units 

Equiv. En la caja de edición escriba conejo,conejos y pulse en el botón Add Editing 

(Añadir edición) . Pulse en OK y cierre el menú.  
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Simular el modelo 
 

 

- Pulse en la caja de edición Runname (Nombre de la simulación) de la Barra de 

herramientas y teclee equilib como nombre de la primera simulación. 

 

-  Pulse en el icono de Simulate (Simular) (o simplemente pulse Intro cuando el cursor está 

en la caja de Runname).  

 

El modelo se ejecutará. Este modelo es tan pequeño que no es posible percibir que ya se ha 

simulado, pero si no está seguro pulse de nuevo en el icono de Simular.  Si recibe un 

mensaje que le pregunta si desea reemplazar (overwrite) la simulación anterior es porque 

esta ya se ejecutó. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Guía del Usuario de Vensim    http://atc-innova.com  13 

Análisis del modelo 
 

 

 

Este modelo ha sido diseñado para mostrar las condiciones de equilibrio en una población de 

conejos. Las constantes de tasa de natalidad  y esperanza de vida se han 

calculado para generar unos flujos de entrada y salida del 12,5% de la Población de 

conejos, y por lo tanto cada ciclo del modelo se halla numéricamente en equilibrio, no 

originando ningún cambio en el valor de Población de conejos.  

 

Herramientas gráficas y tablas 
 

- Pulse en el nivel de Población de conejos en el dibujo.  

 

Esto lo selecciona como la Variable de trabajo; otra manera de hacer esto es seleccionar 

Población como variable de control. Verifique la barra del título en la parte superior de la 

ventana de Vensim para ver que Población de conejos está activa.  

 

- Pulse en el instrumento de Graph (Gráfico). Se muestra un gráfico de Población de 

conejos:  

 

 

 
 

La variable Población de conejos aparece como una línea recta y plana en la parte 

superior del gráfico en 1000 conejos. Para verificar que el valor es constante:  

 

- Pulse en la herramienta Table (Tabla).  

 

Una ventana de salida muestra que esa Población de conejos es constante. Desplace 

la ventana para observar más adelante la simulación, la Población de conejos es 

todavía 1000.  
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Comparación de simulaciones 
 

 

Una característica importante de Vensim es su capacidad de hacer múltiples simulaciones de 

un modelo bajo hipótesis diferentes para probar el impacto que un cambia en las constantes 

(o tablas de datos) tiene en el comportamiento del modelo. Vensim guarda todos los datos 

para todas variables para cada simulación que se ejecuta, para que se pueda conseguir 

acceso fácil a la información acerca del comportamiento de cualquier variable en cualquier 

simulación. Se puede hacer la prueba de modificar temporalmente los valores de las 

constantes o las tablas de datos y entonces simular el modelo. De esta forma, su modelo base 

permanece sin cambios como un punto de referencia inmutable. 
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Crecimiento exponencial 
 

Ahora que estamos satisfechos porque tenemos identificadas las condiciones del equilibrio, 

vamos a hacer cambios en las constantes modelo para generar un crecimiento sin límites. 

Esta es una de las conductas dinámicas, posibles y más sencillas, el conocido como 

crecimiento exponencial. 
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Pruebas de simulación 
 

 

- Pulse en el botón de SyntheSim  . Conteste Sí a la pregunta de si quiere reemplazar la 

simulación actual.  

 

La barra de herramientas cambiará a 

 

 
 

y podrá observar en la pantalla el comportamiento de todos elementos.  

 

 
 

- Pulse en la caja con el nombre de la simulación y reemplace equilib con el nombre growth.  

 

Arrastre el cursor situado debajo de la tasa de natalidad  hasta que indique el valor 

0,2. Si tiene problemas para conseguir el valor exacto suelta el botón de ratón y utilice las 

teclas de la flecha a la izquierda y la derecha del teclado para mover el cursor con pequeños 

incrementos.  

 

Su dibujo debe parecerse a:  
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Las líneas azules muestran los resultados de la simulación actual y la línea roja los de la 

simulación equilib.  

 

- Pulse en el botón Stop (Parada) para parar SyntheSim.  

 

Los gráficos de la conducta y cursores desaparecerán del dibujo.  

 

- Pulse la tecla B o escoja la opción View>Show Behavior (Vista>Muestra 

comportamiento) para ver otra vez el comportamiento de las variables.  

 

Puede alternar entre ver y ocultar la conducta en los gráficos pulsando la tecla B.  

 

 

 

Simulaciones alternativas 
 

Como una alternativa al modo de operar con SyntheSim puede establecer y realizar 

simulaciones de una en una. Para los modelos grandes donde la simulación toma más de 

unos pocos segundos esto es más práctico que tratando de entrar el modo de SyntheSim.  

 

- Pulse en el icono Set up a simulation (Activar una simulación)  

 

La Barra de herramientas cambia a la barra de simulación.  

 

 
 

Esta barra de herramientas tiene las características específicas para crear modelos de 

simulación, permitiendo los cambios a la técnica de la integración, y los botones para 

cambiar las constantes y búsquedas modelo. Advertirá también que las constantes en el 
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modelo de Población se hallan ahora en palabras amarillas con el fondo azul. También, los 

instrumentos de dibujo se han ocultado, previniendo el trabajo en la ventana del dibujo.  

 

- Si no lo ha hecho aún, reemplace en la caja con el nombre de simulación el texto equilib 

con el de growth.  

 

- Pulse en la variable tasa de natalidad  (apareciendo azul/amarillo en el dibujo) y 

en la caja de edición escriba el valor 0.2. Pulse Intro. Este es un cambio temporal sólo para 

esta simulación y no modifica permanentemente el valor en su modelo.  

 

- Pulse en el icono Simulate (Simular) y el modelo se simulará. Si usted ya creó antes la 

simulación growth  en el modo de SyntheSim recibirá una pregunta de si desea 

reemplazarlo. – responda si.  

 

- Si no lo ha hecho ya pulse la tecla B o seleccione View>Show Behavior  (Vista>Mostrar 

comportamiento) para ver los gráficos del comportamiento.  
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Pantalla de análisis causal 
 

- Pulse en Población de conejos para seleccionarlo en la pantalla.  

 

- Pulse en el icono del Control Panel (Panel de control)   para activarlo. Pulse en 

Datasets (Simulaciones) para abrir el control de simulaciones y verifique que ambas 

simulaciones se hallan visibles en la parte derecha de la ventana. 

 

La última simulación (growth) se halla disponible en primer lugar (a la cabeza del menú de 

diálogo). La mayoría de las herramientas de análisis se hallan disponibles para ambas 

simulaciones, permitiendo la comparación del comportamiento de ambas simulaciones.  

 

- Pulse en el icono Grafico.  

 

Aparece una gráfica mostrando ambas simulaciones (ver a continuación).  

 

 
 

- Pulse la tecla Del o pulse la opción de Close (Cerrar) para cerrar el gráfico.  

 

- Ahora pulse en el icono Causes Strip  (Desplegar causas).  

 

Se muestra un conjunto de gráficos Población de conejos y sus causas: 
nacimientos y muertes.  
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Guía del Usuario de Vensim    http://atc-innova.com  22 

Comparar simulaciones 
 

Para descubrir que las diferencias entre la primera y segunda simulación utilizaremos un 

icono que muestra las diferencias en el estado de las Constantes (y tablas de datos). Este 

icono actúa sobre las dos primeras simulaciones ejecutadas (revisarlas en el Dataset 

Control).  

 

- Pulse en el icono Runs Compare (Comparar simulaciones). El  texto siguiente muestra 

las diferencias en la constante de tasa de natalidad para la simulación equilib y growth.  

 

 
 

 

La Población de conejos creció en la simulación growth porque la tasa de natalidad 

fue puesta a un valor más alto que en la simulación de equilibrio. Esto hizo que el ciclo 

positivo a través de nacimientos fuese más fuerte que el ciclo desfavorable por 

muertes, teniendo con el tiempo como resultado un  crecimiento demográfico.  

 

- Escoja el menú Windows>Close All Output (Windows>Cerrar los resultados):  

 

Se cerrarán todas las ventanas que ha creado utilizando los instrumentos del análisis.  
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Disminución exponencial 
 

 

A continuación haremos los cambios a una constante del modelo para generar un descenso 

exponencial en la población. Como el crecimiento exponencial esta es uno de los 

comportamientos dinámicos posibles y más sencillos.  

 

- Pulse dos veces en el nombre de la simulación y escriba decay.  

 

Siga una de estas opciones:  

 

- Pulse en el botón de SyntheSim.  

 

- Arrastre el cursor bajo la esperanza de vida hasta un valor de 4.  

 

- Pulse en el icono de Stop. 

 

O BIEN 

 

- Pulse en el icono Set up a Simulation (Modificar una simulación).  

 

- Pulse en la variable esperanza de vida (apareciendo azul/amarillo en el dibujo) y en 

la caja de edición escriba el valor 4. Pulse Intro.  

 

- Pulse en icono Simulate y el modelo se simulará.  

 

Los pasos indicados anteriormente ofrecen como resultado la creación de la nueva 

simulación decay.  

 

- Pulse en el icono Graph y compare las tres simulaciones.  

 

- Pulse en el icono de Control Panel en la Barra de herramientas principal. En la caja del 

control de simulaciones Datasets pulse dos veces en la simulación equilib en la caja derecha; 

esto eliminará esta simulación de los instrumentos de análisis, que no la mostrarán. Observe 

que puede ser activado de esta misma forma muy fácilmente. (Puede pulsar una vez en el 

nombre de la simulación y utilizar el botón (<<) o (>>) para activar o desactivar la 

simulación).  

 

- Pulse en el icono Control Panel y se generará un gráfico mostrando Población de 

conejos y sus causas — los nacimientos y las muertes, para las últimas 

simulaciones.  
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Los descensos de la Población de conejos en la simulación decay se producen 

porque esperanza de vida tiene un valor más bajo que en la simulación de equilibrio. 

Esto hace que el ciclo negativo por muertes sea más potente que el ciclo positivo de los 

nacimientos, teniendo como resultado el descenso de Población de conejos 

con el tiempo.  
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Entradas y salidas 
 
 

 

Puede utilizar Objetos de Entrada-Salida para crear cursores, gráficos y las tablas de datos 

en un dibujo. Mostraremos esta prestación creando un grafico personalizado.  

 

- Pulse en el icono de Control Panel y escoja la opción de Graphs.  

 

- Pulse en el botón New. Se abrirá el editor de gráficos.  

 

- Entre el título "Población, Nacimientos y Muertes".  

 

- Pulse en el primer botón de Sel y escoja a Población de conejos de la lista.  

 

- Pulse en el segundo botón de Sel y escoja nacimientos de la lista.  

 

- Pulse en el tercer botón de Sel y escoja muertes de la lista.  

 

- Pulse en la opción de Scale a la izquierda entre nacimientos y muertes.  

 

El editor del gráfico personalizado debe parecerse a:  

 
- Pulse en OK.  

 

- Pulse en el icono Entrada-Salida.  

 

NOTA Si usted olvidó de parar el modo de SyntheSim la barra de herramientas del dibujo 

se hallará oculta. Pulse en el icono de Stop y repita los pasos indicados.  

 

- Pulse en un área vacía de su dibujo, debajo y a la derecha del esquema.  
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- Se abrirá la ventana de Entrada-Salida. 

 

  
 

- Pulse en el botón Output Custom Graph  (Gráfico de salida personalizado).  

 

- En el menú desplegable debajo de Custom Graph or Analysis Tool for Output escoja a 

POBLACION_NACIM_Y:MU – que debe ser la única entrada disponible.  

 

- Pulse en OK.  

 

- Ajuste la posición y tamaño del gráfico según lo prefiera.  

 

- Pulse en el nombre de la simulación y modifique decay por experiment.  

 

- Pulse en el botón de SyntheSim.  

 

- Pruebe de mover los cursores y observe los resultados en las variables.  

 

El capítulo 12 Controles de Entrada y de Salida contiene más detalles para personalizar la 

información mostrada en el dibujo.  
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Recursos de Vensim en español 
 
 

http://dinamica-de-sistemas.com 
 

 
 
CURSOS ONLINE 
 
 
 ATC-Innova 
 http://atc-innova.com/ 
 
 
 
LIBROS 
 
 
 Teoría y ejercicios prácticos de Dinámica de Sistemas 
 http://www.dinamica-de-sistemas.com/libros/sistemas.htm 
 
 
 Sysware, la toma de decisiones en un mundo complejo 
 http://www.dinamica-de-sistemas.com/libros/sysware.htm 
 
 
 Ejercicios avanzados en Dinámica de Sistemas 
 http://www.dinamica-de-sistemas.com/libros/ca_sistemas.htm 
 
 
SOFTWARE 
 
 
 ATC-Innova. Distribuidor Oficial Vensim 
 http://atc-innova.com/ 
 
 
 
 
 
 
 
 

Información 
info@atc-innova.com 
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